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Conventionsused in thisguide
The following conventions will be used throughout this user guide. They are illustrated
using the example of printing a document in Microsoft Word.

|:@, File Edit Wiew Insert Format Tools Table

[ corbn
1= & Open. o [ Menu choices are in written in bold in the
e - following format: Menu>ltem>Subltem ...
i Gies g For example, the command used to start
i printing a file would be written as follows:
ersions.. click on File>Print.
Page Setup,..
@, Print Prewiew
: @mr
Send Tn 3
. Thetitles of dialog boxes will be written in
Printer Bold. Clicking on File>Print will open the
Mame: | €68 \\OSEMITELEPSOM Stylus Photo EX x| _ Prope Print dia og box.
?;T:t::s. IEEI!:OI‘»J Skylus Phoko EX
\ihere: LPT1: ™ Print
pcgm m: e On screen buttons, those that appear in the
= al Nurber of copies: program window or in dialog boxes, will be
f::g—t e m om written in bold text and in square brackets:
1 e [Button]. Click on the [OK] button to send
separated by cammas. For example, 1,3,5-12 the fil eto the pn nter

Prinit what: iDocument _V_I Prink: ]nll pages in range
et L% _17< The names of fields in awindow will be

written in Italics. The Namefield displays
the current printer.

1 v Callake
Choices available from lists will aso be

= written in “quotation marks’. Click on the
- arrow of the Print field to display the
choices available. Click on the “Odd pages’
choiceto print only the odd pages of a
document.

=12

vi Pink: Al pages in range

Physical buttons, such as on the GPS, will
be referred to as keys and their names
written in Bold text. For example, press and
hold the Power key on the GPS to turn it on.
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Introto Map76 buttons and functions

Layout of the Garmin GPSM ap76

Button descriptions:

Power Key

: The Power key is used to turn the unit on and off. Press and hold the Power

key to turn off the GPS

Rocker Key: The Rocker key is used to control the movement of the cursor on menus

Page Key:

Quit Key:
Menu Key:

Enter Key:

Nav Key:

and map displays

The Page key is used to navigate through the 5 main display pages. The
Page key will aso end and operation in progress and return to one of the
main pages

The Quit key is also used to navigate through the 5 main display pagesin the
opposite direction of the Page key.

The Menu key will display the page options menu for the current page.
Pressing the Menu key twice will display the main options menu.

The Enter key is used to activate a data field or make a menu selection.

Pressing and holding the Enter key will alow the user to capture the current
position as a waypoint.

The Nav key is used to start or end navigation functions. Holding down the
Nav key will store the current position and gives you the opportunity to begin
navigating back to that marked point.

Zoom In and Zoom Out Keys: These keys adlow you to view a smaler area of the

displayed map in greater detail (Zoom In) or a larger area in more general
detail(Zoom Out).
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Turning the on the GPS and putting it Simulator Mode

Power up GPS configuration 1 by connecting the power cord of the QuadCom cable to
the external battery. The LED on the power cord should light as well as the screen of the
MBX beacon receiver. See the assembly instructions at the end of this guide for more
detail.

Turn on the Map76 by pressing and holding the Power key.
The Map76 has three introductory screens, illustrated below. Press the Page key to get
past them to the main pages of the unit.

Y ) &

-

GARMIN GARMIN GARMIN

©2000, AND DATA IRELAND,
LTD. WARNING

GP _S_map All data is presented

for reference only.

76 You assume total
responsibility and
: risk associated with
Copyright 2001 using this device.
GARMIN Corp.
All Rights Reserved Press to continue Press to agree

The Map76 has a ssmulator mode in which the unit is on but is not looking for satellites
to measure a position. Simulator mode does not display your real position! Simulator
mode is useful when you are practicing inside, where the unit cannot receive satellite
signals. You will aso want to have the unit in smulator mode any time you have it
connected to your PC for data download or upload.

This mode is started from the GPS I nfor mation page, usualy the first page that opens
after the introductory pages. To start smulator mode:

ZFEED ELEWATION ACCURACY
™

= Pressthe Menu key once with the GPS I nfor mation page open. e s =y
Acquiring Satellites

» UsetheRocker key to highlight the “ Start Simulator” option from =
the list.
. | Track Up
= Pressthe Enter key to accept the choice

|New Elevation

|New Location
for Main Menu

= Exit the smulator mode by repeating this procedure and choosing the
“Stop Simulator” option. 28-
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Main Screen Descriptions

There are five (5) main pages on the Map76.
The pages are:

The GPS Infor mation Page
The M ap Page

The Pointer Page

The Highway Page

The Active Route Page

These pages are arranged sequentially on the unit, like on a Rolodex. The Page and Quit
keys are used to navigate between the pages.

For example, if you are viewing the GPS Information Page and you want to see the
Highway Page, you can get there by pressing the Page key three times or the Quit key

twice.
Map Page Pointer Page
SPEED m [PIST T HEXT m SPEED m [BIST T0 HEXT n
L) 1 (1 1 ] : 0.0 5 0.67 i
D Adamson Gallery
|
y e il B0
GPS Information Page Highway Page

sp:[:‘ln []"‘ Eliivsﬁigorh . ME;E‘ SPEED [BIST TO HEXT

A0 Tow.0 | dhat i f
. Sil'l'll.lllltil'ls GPS cnung.o nrrconu.RgT

; . 040°  0.00

09 - I I II Adamson Gullerv

{ . oo bo| g 04 07 08 0 1
IZI fAdamson Gallery
2028 e e e e K G

04-JAN-02 04:54:19 Active Route Page

Hogggg;gg: Active Route

: 'ADMSNG-THHSJF
Waypoint ) Distance »

"

fidamson Ga _.—-"
*Washington 0.30°
Lincoln Mem 1.11°

Thomas Jef JF-Ait%

Total 2.04"

FagE O Or ZI
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GPS Information Page

The GPS I nfor mation page provides you with information about your position, the
satellites that are being used to measure that position and an estimate of the accuracy of
the location information that the GPS is giving you. All thisinformation is displayed in
the following fields:

SFEED ELEWATION ACCURACT

. 0.0" |185.4- 49.2° Receiver Status

Simulating GPS Message
Sky Map— | ;“I Satellite Strengtr
\ Indicator Bars

04-JN-02 045419
o o N 38.88744°
oster NOT702995°

= The Sky Map shows the location of the satellites in the sky overhead. The outside
ring represents the horizon. The inner ring represents that portion of the sky that is
midway between the horizon and directly overhead.

= Thebars Sgnal Strength field show the status and strength of the signal being
received from each GPS satellite in the sky. The bar will be light gray if the unit is
receiving information from the satellite indicated by the number at the base of the bar,
but the receiver is not yet locked on. The bar will be black if the unit islocked on to a
satellite and using that signal to calculate aposition. A “D” in the bar will indicate
that a differential correction signal is being received for that satellite.

=  The Speed and Elevation fields are self-explanatory. The unitsthat are displayed can
be atered in the settings of the unit.

= TheAccuracy is an estimate of the quality of the position that you are receiving based
on the geometry and signal strength of the satellites being used to calculate the
current position.

» TheDateand Timefields are self-explanatory. The time that the GPS receivesis
Universal or Greenwich Mean Time, which means that you need to set the correct
time zone to get local time

= ThePosition field is your location on the face of the Earth in the coordinate system
that is set in the location settings of the unit.

=  The Receiver Status message will indicate the type of position that the receiver is able
to calculate.
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The Receiver Satus Messages are as follows:

= Autolocate — Directs the receiver to individually locate each satellite

= Acquiring Satellites — Receiver is looking for satellites and will display this message
until it acquires at least three

= 2D GPS Location — The receiver is using only 3 satellites and can only calculate
horizontal position

= 3D GPS Location — The receiver isusing at least 4 satellites and can calculate altitude
as well as horizontal position

= 2D Differential Location — The receiver isusing 3 satellites and a form of differential
correction to calculate horizontal position only

= 3D Differentia Location — The receiver isusing at least 4 satellites and a form of
differential correction to calculate horizontal positionand atitude

= Lost Satellite Reception — The receiver is not able to receive satellite signals

=  Simulating GPS — The unit is running in simulation mode and the actual GPS receiver
isturned off

Map Page

The Map76 comes with a built in basemap that will be displayed on the '3”‘“’0 PRENIT
map page along with your current position and any waypoint or track .
data stored on the GPS.

= A black arrowhead surrounded by a circle indicates your current
position on the map.

= Thedirection that the arrow is pointed indicates the direction of
your travel. The arrow will point north if the receiver is not moving
or in simulator mode.

= Thecircle shows the extent of the estimated accuracy. For example, _
if the estimated accuracy is 25 feet, the circle will have aradius of 'SPE‘DO 0
25 feet. A

DIST TO HEXT
m | it
h i
Ll

Hup Pointer 'H_38.88621
. 3055 147.3} HO77.02873
= There are many settings that can be chosen for the map page.
0 The map orientation can be changed so that the direction of A
travel, magnetic north, or true north will always be on top. corow A
0 The number of fields at the top of the screen as well as the type R

of data displayed in them can be changed.

80%
OWErZO0M

b L3 Mlr b

0 Pressthe menu button once to display the options for this, or
any other, page.
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Pointer Page

[SPEED m [DIST T HEXT r
The Pointer page is used in navigation. 00“ 067
fidamson Gallery

=  The compassring is used for reference.
= The Vertical line shows the direction of your travel.

= The pointer shows the direction to the point to which you are
navigating.

= The compass directions are based on your changing position,
not a true compass, so the unit must be moving to get atrue
reading.

Highway Page .spm:.o org .-DIS'TOTD ETT ;

COURSE u OFF COURSE

The Highway page is aso used for navigation. 040T [][]0‘t
To use this navigation mode, the user follows the road on the Adamson Gallery
screen, keeping the position icon (black arrowhead) on the white

line. Waypoints and other features can be displayed on the Adamson Gallery

screen. The properties of this page can be accessed and changed
the same way as on other pages, by pressing the menu key once.

Active Route fictive Route
'ADMSNG-THMSJF

Wavpoint - Distance b

The Active Route page assists the user with navigation. The

information on this page will vary depending on the type of Aidamson Ga _.__"
navigation you are doing. Mashington  0.30°
= |f you are navigating a route the active route will display the Lincoln Mem  1.11:

points of the route. (LRI, Sl

= If you are navigating a track, the page will show the turning
points of the track.

» |If you are navigating to a point, the name and distance to Total 2.04
your destination will be displayed on this page.
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Setting up the Garmin Map76

The Map76 has a number of settings may be specified to make it’s display more useful to
you. Additional values for other settings need to be specified in order to allow the unit to
work with other hardware, such as your office PC or the DGPS beacon receiver.

All of the unit settings are accessed from the Setup page.

To open the Setup page:

» Pressthe Menu key twice from any screen to bring up the Main
Menu. Usethe Rocker key to highlight the “ Setup” option and
press the Enter key to open the Setup page

» The Setup page has a number of tabs, each onerelating to a
different subject area. The tabs are Genera, Time, Units, Location,
Alarms, and Interface.

= Once the proper settings have been entered into the Setup page,
return to normal operation by pressing the Quit key once to reach
the Main Menu and once again to return to the main pages of the
unit.

Setting the Time Format

The Map76 unit will acquire a very accurate time reading from the GPS
satellites, but that timeis set to Universal or Greenwich Mean Time.
To set the proper time zone:

= Navigate to the Time tab of the Setup page

= UsetheRocker key to highlight the field you need to change, Time
Zone for example, and press the Enter key to bring up a dialog with
alist of choices for the field.

» UsetheRocker key to select one of these choices and press the
Enter key to accept the new setting.

Page 9 of 21
09/24/02

Main Menu

Trip Computer
Tracks

Points

Routes
Proximity
Celestial
MapSource Info
System Info

Light Memory  Power

[l o A1t 17

[T Time Units L:
Mode

Simulator

WAAS

Enabled

Backlight Timeout

15 Seconds

Beeper

Off
Language

English

al Units Locatior
Time Format

12 Hour

Time Zone

Eastern

Daylight Savings Time

Auto

Current Date

05-HAR-02

Current Time

02:21:04%

General Time | Unite L:
Time Format

12 Hour

Time Zone

Central

i Mountain
Pacific

 Alaska

Hawaii




Setting the Unit Format

The Map76 can display distance and speed using different units of measure. In the
USDA we will most often want to know distance and speed in feet and miles. These are
referred to as statute as opposed to metric or nautical units.

General Time Units L:
Elevation Depth

= Navigate to the Units tab of the Setup page and then down to the  Feet Feet
“Distance and Speed” field. Distance and Speed

' Nautical :
* Pressthe Enter key to open adialog box with the choices for this | Metric jay
field. Select the “ Statute” choice and press Enter to accept the Numeric Degrees

choice. Speed Filter
Auto

Setting the L ocation Format

The location obtained by the Map76 can be displayed in a number of different format and
datums. Location settings affect only the display of the position on the GPS. The data
that is collected on the GPS can be exported in any format, regardless of display settings.
The location format and the proper datum are set on the Location tab of the Setup page.

= Most USDA applications will call for the NAD83 datum
7ime Units Location A
Location Format
= TheLocation Format field should be set to either: :d':d;ddddd
0 “hddd.ddddd®” Decimal Degrees Seconds of Latitude and
Longitude Horth Reference
True

Hagnetic Yariation

0 “ddd°mm.mmm” Degrees and Minutes Seconds of Latitude
and Longitude

0 “hddd°mm’ss.s” Degrees Minutes Seconds of L atitude and
Longitude

o “UTM UPS’ UTM coordinates. CAUTION: This setting will aways use the
geographic boundaries of the UTM zone to determine what coordinates to display.
In counties that are split by a UTM zone boundary, USDA will choose to use the
UTM zone that holds the majority of the county to do mapping of the entire
county. This could cause a disagreement between your USDA maps and the
coordinates displayed on the GPS receiver.
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Setting the Interface Mode

The Interface setting on the Map76 specifies the type of communication messages that
the GPS is sending out and receiving through the Power/Data port in the back of the
unit. The GPS uses these messages to communicate with the office PC or the DGPS
beacon receiver. Each of these devices requires a different communication protocol.

Navigate to the Interface tab of the Setup page

The Serial Data Format field on Interface tab has Eight settings to
choose from. USDA will be using one of the two following settings:
“GARMIN” and “RTCM In/NMEA Out”.

tion Alarms Interface
Serial Data Format

= The“GARMIN” setting will be used to communicate with the PC -;GnRHIH DGPS
and if the GPS is being used in Stand Alone mode. |NMEA
|Text Out
RTCH In
= The“RTCM IN/NMEA Out” setting is used to communicate with | RTCH In/NMEA Out
the beacon receiver. 'ETCM In/Text Out
|None

The “RTCM In/NMEA Out” interface setting has a number of parameters that need to be
set in order to communicate with the DGPS beacon receiver.

The Beacon field can be set to the values “User” or “Scan”. The ts"'!‘l ?'t‘"'r““ m
“User” setting allows the user to manually enter the parametersfor — \caRMIN

beacon reception. These settings will be discussed in the next

section. The “Scan” setting tells the unit to conduct an automatic

search for available beacons. The “Scan” setting does not always

produce the best results, so the “User” setting is often preferable

The frequencies and bit rates for the operating DGPS stations in the
US can be looked up by name on the Coast Guard' s website at:

http://www.navcen.uscg.gov/ADO/DgpsSel ectStatus.asp

Itlon Alarms Interfoce
Serial Dato Formet

RTCM In/NMER Out _

The location of the nearest beacon to you can be determined from the
map included in this user guide or from the website.

The Freq field is used to set the beacon frequency. Enter the proper
frequency by using the Rocker key to highlight the Freq field and the
pressing the Enter key. Set the each of the four digits of the
frequency by using the Rocker key up and down to select the digits
and left and right to move between the digits.

The vaue for the Bit Ratefield is chosen from alist in a diaog box,
similarly to the other fields on the Setup page.
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= When aDGPS signal is being received the Status field will display the value
“Receiving” and the SNR field will show avalue for the signd to noise ratio of the
signal that you are receiving. The Distance field may be populated as well to show
how far you are from the beacon signal that you are receiving. That will depend on
the individual beacon and your timing in tuning in to the beacon.

= |f aDGPSsigna isnot being received, the Satus field will display the value “Check
Wiring”. While this message could indicate that the wiring to your beacon receiver is

not connected, you will get the same message if there is no beacon coverage at your
location.

Setting the unit to receive WAAS

If you want to use the WAAS signal for differential correction, you must enable the
Map76 to use that signal. This setting is located on the Genera tab of the Setup page.

General Time Units L:
Hode

Simulator

WAAS ;
{Enabled |1t

| Disabled as

Beeper ;

Key and Message

Language

English

The WAAS field has two settings “Enabled” and “ Disabled”
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DGPS Beacon L ocation

The locations of DGPS beacons in the United States are illustrates in the map below. A complete list of the locations and operating
parameters of all NDGPS beacons can be viewed and downloaded from:

http://www.navcen.uscg.gov/dgps/DgpsCompl eteConfiguration.htm

DGPS coverage depiched in gray shade.

Calendar Year 2002 DGPS Coverage

Black triangles reprasent DGPS broadcast station locations.

Coverage based on USCG published inforrmation.

Coverage representation is an estimate only and does nol
raflect actual broadcast signal strengths, atmospheric
conditions, and tarrain vanabllity that can affect DGPS reception. :Aﬁ.m Map prepared by USDA-NRCS. National Cariography & Geospatial Center

Albars Equal Area Conic Projection, NADE3

Fort Waorth, Texas to support USDA Real-Time DGPS activites,
March 2002
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M apSour ce Softwar e

The USDA GPS units will be shipped with a program called MapSource. MapSource
can be used to upload and download data to the GPS as well as doing some basic map
making. The program ships with data CDs that contain road, feature and topo maps for
the whole country. Though the program has a number of capabilities, we will be using it
primarily to load background maps into the Map76.

Connecting the GPS to the Computer:

= The GPS needs to be connected with a cable to your PC in order
upload background maps.

= The cable that you will use has around 4-pin connector that
attaches to the round port on the back of the GPS and a 9-pin serial
cable that attaches to a COM port on your PC.
=  Turn on the GPS and put it in Simulator mode (Page 5 of this Guide).
= Set the Interface on the Map76 to “ Garmin”.

Sdlectingamap in MapSour ce:
EP

CHjcF

Ba [a Foiice (=133

Y Zomnie
(Lo B Sy s
Hera Lo O ul Fegan L

There are three MapSource CDs, one for the
Eastern US, one for the Western US and one for

<P Muplasl (WG

ET— Alaska and Hawaii. The program will prompt you
o= e R for the correct disk when you need it.
s e T T | it Find the location that you need with the Find City

tool or by using the Zoom tool on the base map.

T To usethe Find City tool:

e Be | = Select the region of the country that you are
2 interested in using the menu View > Region and
then selecting from one of the 4 regions
displayed
e, — = Openthe Find City dialog by clicking on View
fire > Find City. The dialog box will show alist of
] Bae o2} the cities that MapSource has in its database.
Emo o U You can locate one of the cities by scrolling
[Ertamy 1 o through the list or by starting to type the city
e W s name into the input field of the dialog box.
e | Select the city by clicking on the city name on
the list.
Pagel4of 21
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SR i

Map Scale

ﬂ Plaam rmins tha dek LE Toa - End* i dosa [

Pruzx Carcal ko vl 6P Mg Dt

I
Rl

1 |

Dok (ER

Ml e | |

£
Diferws Eeleciend (s Lon Fubcdd ke Pallat B

Center the map display on by clicking on the
“Center On City” button on the Find City dialog

box. The map will remain in the same scale that
it opened in.

To zoom in or out, choose a different map scale
from the drop down list in the scale tool on the
tool bar. The program will give you a“Disk not
in Drive” message and prompt you for the proper

CD if you do not have the correct CD in the
drive

Refine your search for a map by panning using

the scroll bars or by zooming with the zoom tool
described in the next section.

To usethe Zoom tool:

If you have not aready, select the appropriate
region of the country using the menu View >
Region and then selecting from one of the 4
regions displayed.

Sdlect the Zoom Tool from the Tools Toolbar
by clicking on it

Use the Zoom Tool to draw abox around your
area of interest and the map will zoom down to
include only that areain the display

[ G e Juk ten

Lo 3 1= 1 B S e L o=

R

PEE | Wi | P | Tromi | R, i =,
] bl p s L Kt == T T ¥
=3
o
| TP Y Al I
2 T
F, el i
W T T IS
(MR ""i'lh‘l .
B * I
sty < &
: _II et _xd T
Dms- | I.—— g
i e | J - — T I_-I ol
O s L erradd eddT fa Tl 0 e O L el S

Pagel50f 21
09/24/02



Uploading the map to the Map76:

MapSource divides its basemap data into tiles that

Bl Edb - Use Tk B

Dicials| alsl oesz] = 2 a] are generally between .5 to .25 degrees of longitude
tdf'rilll: |elefrm = in width and the same range of degrees of latitude in
s 1 | wrpeni | n-mﬂ T

height. The length of a degree of latitude is
approximately 70 miles, longitude is the same at the
equator but gets smaller as you travel toward the
poles.

MIPRIE SOUTH LBE Togmas
T LA, A IWESTT Toponas

= Usethe Map Tool from the Tool Toolbar to
select the map or maps that you need to load into
the GPS.

Ewaph HEH

Diitmrw: Beleoind— LsdiLon i ddcd Twis B0 [

= Panning across the map display with the map
tool will display the boundaries of the map tile in
yellow. Clicking on amap tilewill add it to the
Maps Tab on the left side of the program
window and turn the selected map background
color to pink.

Ol=lala] alal | sl ]| B
e o L ) [

MIFRIE SOUTH.LA . Topar
TALLULSH, LAME fWTET] Toparas
MOMROE SOUTH L0f . Topanss

, . : = All the maps that are listed in the Maps Tab can
MmE U ot Taa Lanesy be loaded onto the Map76, up to its memory

HOMRIERDFTH. LA K Toparea

REAE U e : capacity of 8mb.
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i k |
Cancel

—what ToSave

v Maps

Select &l Select Mone

G abing w4 hEP5 MAF 76 B oltears Veron 2 08
Sz hed b 115200 bened
Tramulfpaing reapet E0

_ oo |

_ City
Mangham H 32.30530
245° ELL Wi S _Ho91. 77979

[CHUUUD =) iy
| L
'\?_MIHGD:"QLE F

fra 2 WA, ALl
ERTO e, b Iﬁ .HIHNSBDRD
R T o

E‘Lumm g -:' “BREUHELL CDMU

ﬂ-l o
Frmopsources }BUIEI \.JGILBERT._

Map display on the Map76

The leve of detail and type of features displayed on the base map

= Click on the Save to GPS button on the Tool
Bar to open the “Save To GPS’ dialog. Make
sure that the Maps check box is checked and
click on the OK button to start the upload to the
GPS.

= A datusdialog box will show the progress of

the download.

All of the detailed data on the maps, including topo
lines, road detail and places will be available for use

in the GPS.

City

Hangham
2463 944.7"

MapSoUrce

H_32.30530
HO9 1. 779797
T TICT 0TI

can be chosen from the M ap page of the Map76.
* Pressthe Menu key with the M ap page open

» UsetheRocker key to highlight the “ Setup Map” option and
pressthe Enter key to open the Map Setup page

= TheMap Setup page has 11 tabs to control the display of the

basemap.

» UsetheRocker key to navigate among the tabs and the options

on those tabs.

= Choose options in the same manner as on the Setup page and
elsewhere on the GPS unit
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Assembly of Configuration 1

Route the screw end of the black antenna
cable from the inside of the backpack out
through the hole in the top right corner of
the backpack.

Slide the antenna mast into pocket on the
same side of unit as the antenna wire.
Secure the mast in place by threading the
velcro strap through the dot in the mast.

Screw the gray thread adapter into the
antenna and then screw the antenna
assembly onto the antenna mast

Place the MBX receiver into the internal
pocket in the backpack with the
connections facing the bottom of the pack
and the writing on the face of the MBX
running from left to right as you face the
open backpack.

Connect the Quadcom cable to the MBX

unit as is shown in the photo. The

Quadcom cable has two cables that attach

to the MBX

= 1) around, locking, two-pin femae
connector that connects to the “PWR”
port on the MBX

= 2) afemale seria cable that connects
to the “DATA” port on the MBX.
Both of these cables are green in
color.

Connect the black antenna cable to the
MBX port labeled “ANT IN”

Connect the thin gray cable to the MBX
port labeled “GPS OUT”

Run about 3 feet of each of the Gray
cables out one of the openings in the door
of the backpack.
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= Connect the gray, round, 4-pin connector
to the port in the center back of the
Map76.

= Connect the thin, gray cable to the small
port located on the top right corner of the
back of the Map76

= Connect the MBX to the battery by
inserting the car-lighter type plug into the
receptacle connected to the battery. The
battery will power both the MBX and the
Map76 when the whole system is wired
together.

= The battery didesinto one of the two thin
internal pockets of the backpack and
should be located toward the bottom of
the backpack.

» The Map76 can use 2 AA interna
batteries as well run on external power.
Open the battery door on the back of the
unit by turning the metal D-ring ¥ turn
counter-clockwise then pulling straight
away from the unit.
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Assembly of Configuration 2

Antenna Bottor

Attach the magnetic mounting plate to
the bottom of the external antenna using
the two (2) screws included in the
antenna package

Screw the stedl disk onto the threads on
the top of the antenna mast

Slide the antenna mast into one of the
side pockets of the backpack, secureit in
place by threading a velcro strap through
the dot in the mast

Place the antenna on to the steel disk on
top of the antenna mast. The magnet on
the antenna will hold it in place

Thread the antenna wire through the dots
in the door of the backpack. Thiswill
help to keep the antenna wire out of the

way.

Connect the antenna cable to the port
located in the upper right corner on the
back of the GPS unit.

This GPS configuration is powered by
the AA batteries in the Map76.
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